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Table S1. Number and Directionality of Junctional Extensions in hmp-1(fe4) and hmp-
1(fe4);unc-94(RNAi) Embryos 
 
 

 # embryos 
analyzed 

# total 
extensions 

(>= 0.5 mm) 

# non-seam 
directed 

extensions 
(>= 0.5 mm) 

# seam 
directed 

extensions 
(>= 0.5 mm) 

hmp-1(fe4); 
 jac-1::gfp 

21 48 
(2.3 / embryo) 

 

22 
(1.0 / embryo) 

26 
(1.2 / embryo) 

hmp-1(fe4); 
jac-1::gfp; 
unc-94(RNAi) 

18 97 
(5.4 / embryo) 

60 
(3.3 / embryo) 

37 
(2.1 / embryo) 
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Figure S1. Additional Analysis of HMP-1 and UNC-94 Interactions  
A. Western blot showing reduced expression of UNC-94 in unc-94(RNAi) embryos.  Lysate from 30 N2 or 
N2; unc-94(RNAi) worms was loaded in each lane and probed for either UNC-94 or actin. Western blot 
showing reduced expression of UNC-94 in embryos treated with unc-94(RNAi).  Lysate from 30 N2 or N2; 
unc-94(RNAi) worms was loaded in each lane and probed for either UNC-94 or actin.  RNAi was 
performed via feeding. B. HMP-1 and UNC-94 do not coimmunoprecipitate. SU265 (hmp-1::gfp; dlg-
1::dsRed) embryos were collected and extracts collected as described in Experimental Procedures. Extracts 
were subjected to immunoprecipitation using anti-GFP antibodies, and the resulting non-precipitated 
proteins (input) and immunoprecipitates (IP) were blotted and probed using anti-GFP (αGFP), anti-HMP-2 
(αHMP-2), or anti-UNC-94 (αUNC-94) antibodies. Whereas there is robust signal for HMP-1::GFP (top) 
or HMP-2, a known HMP-1 binding protein (middle) in the IP, there is no detectable UNC-94 (bottom), 
although there was abundant UNC-94 in the original extract (bottom, left). C. UNC-94 staining in the 
pharynx.  In wild-type elongation-stage embryos, 100% show staining for UNC-94 in the pharynx (n = 
79).  In hmp-1(zu278) embryos, 86% have UNC-94 staining in the pharynx (n = 87). In hmp-1(fe4) 
embryos, 100% of elongating embryos show staining for UNC-94 in the pharynx (n = 63). Bar = 10 µm. 
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Figure S2. Junctional-Proximal Actin and Circumferential Filament Bundles (CFBs) Are 
Perturbed in unc-94 Loss-of-Function Embryos   
Phalloidin staining of actin in ~1.5-fold embryos. Phenotypic defects were categorized into three 
classes.  (A) In Class I embryos (wild-type embryo shown), there is a clear thin band of actin at the 
junction (white arrowhead), evenly spaced CFBs, and a dense meshwork of actin in seam cells.  (B) 
In Class II embryos (unc-94(tm724) embryo shown), there are clumps of CFBs (arrow), but the 
overall amount of actin in the embryo is not decreased. Muscle organization is also perturbed (yellow 
arrowhead). (C) In Class III embryos (unc-94(RNAi) embryo shown), there is clumping of junctional 
actin and often a substantial decrease in the amount of actin present in seam cells (not visible in this 
example). As in Class II embryos, muscle organization is perturbed (yellow arrowhead). (D) 
Distribution of phenotypes for the three genotypes of embryos screened (wildtype, n=13; unc-
94(RNAi), n=19; unc-94(tm724) n=11). For all images, anterior is to the left; bar=10µm. * = 
significantly different, p < 0.05. unc-94(RNAi) and unc-94(tm724) are not significantly different (p = 
0.32). 
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Figure S3. The Adherens Junctions of hmp-1(fe4);unc-94(RNAi) Embryos Exhibit Abnormal 
Dynamics in Living Embryos  
JAC-1::GFP localization was assessed in living embryos using spinning disc confocal microscopy. 
(A, B) unc-94 loss-of-function results in slightly perturbed adherens junctions. (A) unc-94(RNAi) 
embryo.  Regions of JAC-1::GFP mislocalization (arrow), were observed in 3 out of 23 embryos 
examined.   (B) unc-94(tm724) embryo. (C) hmp-1(zu278) embryo. In 6 out of 6 embryos observed 
(at the 1.25-1.5 fold stage), the seam:ventral/seam:dorsal borders exhibited dislocation of JAC-
1::GFP reminiscent of, but not quite as dynamic as, that seen in hmp-1(fe4);unc-94(RNAi) embryos. 
(D, E) let-502(RNAi) ameliorates the junctional dislocation in hmp-1(fe4);unc-94(RNAi) embryos.  
(D) Arrested hmp-1(fe4);unc-94(RNAi) embryo showing dislocated JAC-1::GFP.  (E) Arrested hmp-
1(fe4);unc-94, let-502(RNAi) embryo.  Some regions in C and D are slightly out of focus due to the 
shape of the embryos and movement due to muscle twitching.  Bar = 10 µm. 
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Figure S4. Tissue-Specific Requirements for HMP-1 and UNC-94 Function and Effects of LET-
502/ROCK on Junctional-Proximal Actin  
A. Tissue-specific rescue of defects in hmp-1(fe4);unc-94(RNAi) embryos indicates a major 
requirement for HMP-1 and UNC-94 in non-seam epidermal cells. hmp-1(fe4) hermaphrodites 
expressing Pnhr-73::hmp-1::gfp (expressed in seam cells) or Pelt-3::hmp-1::gfp (expressed in non-
seam cells) were subjected to unc-94(RNAi) via feeding or fed control bacteria (L4440), and progeny 
scored for developmental arrest. ** = significantly different, p < 0.001. B. Loss of let-502/Rho kinase 
function leads to shorter cells with thicker UNC-94-positive junctional proximal actin bands. let-
502(sb118) embryos were temperature-shifted as described in Experimental Procedures and 
immunostained for AJM-1(to determine overall cell shape) and UNC-94. The thickness of the UNC-94-
containing junctional proximal band was measured as shown and plotted against length/width ratio for 
let-502(sb118) and wild-type embryos. A power curve was used to fit the resulting data. 
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Supplemental Experimental Procedures 

Strains and Alleles 

The Bristol N2 strain was used as wildtype. hmp-1(fe4) [1] was maintained as a heterozygote over 

lon-3(e2175) as a marker for the wild-type chromosome.  The previously described jac-1::gfp 

transgene [1] was integrated via gamma irradiation (jcIs24), outcrossed six times, and homozygosed 

to generate the strain SU295.  Crosses were performed to introduce jcIs24 into hmp-1(fe4)/lon-

3(e2175) and into unc-94(tm724).  unc-94(tm724) was obtained from Shohei Mitani (National 

Bioresource Project for C. elegans, Tokyo Women’s Medical University School of Medicine, Tokyo, 

Japan).  The unc-94(tm724) allele has a 695 base pair deletion and 17 bp insertion that might result in 

a frame shift after the third exon. 

A strain (ML753) expressing a gfp-tagged fragment of vab-10 that binds F-actin in epidermal 

cells (VAB-10(ABD):GFP [2]) was mated with unc-94(tm724) or hmp-1(fe4) males and the relevant 

mutation was rehomozygosed to create strains used in spinning disc confocal filming experiments. 

HR1157 carries a let-502 temperature sensitive allele (sb118) that was kindly provided by Paul 

Mains (University of Calgary). 

Tissue-specific HMP-1 rescuing constructs were made using Fusion PCR [3]. The nhr-73 

promoter was used for seam-specific expression and the elt-3 promoter was used for non-seam 

epidermal expression. Phusion Polymerase (NEB) was used to PCR amplify ~1kb of the nhr-73 

promoter (5' CTTGAGCAACAATTTTCAGAGCAGTGGAGGTTTTGT3' forward and 

3'CCATTCGCAGGCAT TCTGAAAATTAATTTTTCTTCAAACTTGCC5' reverse, with 25bp 

overhang for hmp-1) or ~2kb of the elt-3 promoter (5' 

ACCGAAATGCCGATGGACATATCAAATGTGAAGACA3' and 

3'CATGAGAATTGCCATTCGCAGGCATGAAGTTTGAAATACCAGGTAGCCGA5' reverse, 

with 25bp overhang for hmp-1) from C. elegans genomic DNA. hmp-1::gfp was PCR amplified using 

Phusion Polymerase with pJS434 [4] as a template (5' TAATTTTCAGAATGCCTGCGAATGG3' 

forward and 3' GCATAGTTAAGCCAGCCCCGACACC5' reverse) for fusion to Pnhr-73 or 

5'ATGTGTCAGAGGTTTTCACCGTCAT3' forward and 

3'ATGTGTCAGAGGTTTTCACCGTCAT5' reverse for fusion to Pelt-3). Fusion PCR was 

performed to connect these two nested PCR products using Go Taq Long (for Pnhr-73::hmp-1::gfp: 

5'TATGTGTCAGAGGTTTTCACCGTCAT3' and 3'ATGTGTCAGAGGTTTTCACCGTCAT5'; for 

Pelt-3::hmp-1::gfp: 5'GTTTCTACTGTTTCAACATTATGTGTCAGAGGTTTTCACCGTCAT3' and 

3'ATGTGTCAGAGGTTTTCACCGTCAT5').  

Fusion PCR constructs (Pelt-3::hmp-1::gfp and Pnhr73::hmp-1::gfp) were injected into hmp-1(fe4) 

worms. At least two reactions were pooled for injection to minimize the chance of proofreading 
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errors. About 80ng of the Fusion reactions were co-injected with Pttx-3::dsRed into the gonads of hmp-

1(fe4) worms. Expression of the HMP-1::GFP constructs in either seam or non-seam cells was 

verified with confocal microscopy.  

 

Antibodies 

A polyclonal rabbit anti-UNC-94 antibody was produced and affinity purified by the Proteintech 

Group, Inc. (Chicago, IL) using amino acids 144-401 of UNC-94b as the antigen as previously 

described [5].  Rabbit anti-HMR-1 antibody was generously provided by J. Priess (Fred Hutchinson 

Cancer Research Center, Seattle, WA).  MH27 antibodies were purified from ascites fluid (Harlan 

Sprague Dawley, Madison, WI) from hybridoma cells obtained from the Developmental Hybridoma 

Bank (Univ. of Iowa).  A monoclonal anti-actin antibody (C4, MP Biomedicals, Irvine CA) was used 

for Western blotting. 

 

Feeding RNAi Screening 

The C. elegans Chromosome I feeding RNAi library in 96 well format was used for screening [6].  

This library contains 2,445 bacterial cultures (HT115 (DE3) strain) each expressing a unique feeding 

RNAi clone.  A starter culture (LB with 25 µg/mL carbenicillin and 12.5 µg/mL tetracycline) was 

inoculated with a replicator tool, using frozen material from the library plates, and grown overnight at 

37oC.  A second culture (LB + 25 µg/mL carbenicillin) was inoculated using material from the starter 

plate and cultured overnight at 37oC.  10 µL of this culture was spread onto triplicate wells of 12 well 

plates containing Nematode Growth Media [7] supplemented with 25 µg/mL carbenicillin and 1mM 

isopropyl β-D-thiogalactopyranoside (IPTG).  The bacteria were grown overnight to generate a thin 

lawn.   

Approximately 20-30 L3-L4 hmp-1(fe4) worms were seeded onto one well for each clone to be 

tested.  After allowing the worms to feed for 24 hours, 8 were singled onto each of the two remaining 

wells for each clone.  After another 24 hours, the worms were removed from the plates.  Over the 

next two days, the wells were visually scanned to determine the approximate percentage of embryonic 

lethality.  Feeding RNAi for wild type worms was performed in a similar manner except that 10-15 

worms were seeded in the initial well and four were singled into the duplicate wells.  In each round of 

the screen, hmp-1(fe4) worms were fed the empty feeding vector, L4440[8], as a negative control and 

a feeding vector for the known hmp-1(fe4) enhancer, unc-34 [9] as a positive control. 

We identified 44 transcription units that, when depleted with feeding RNAi, enhanced the 

lethality of hmp-1(fe4) to 95% or greater, and yielded less than 12% lethality in wild-type. A 
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secondary screen was performed to confirm putative enhancers using a different source of double-

stranded RNA (dsRNA) and RNAi by injection. 

 

RNAi via Injection and Dead Embryo Counts 

dsRNA was injected at 2 µg/µl into one gonad arm per worm, with the exception of let-

502(RNAi), which was injected at 1 µg/µl to avoid early arrest due to cytokinesis defects.  To score 

for embryonic and early larval lethality, worms were cultured for 12-16 hours after injection and then 

singled onto new plates.  The embryos produced over the next 24 hours were scored for lethality.  To 

obtain embryos for phenotypic analysis, worms were cut transversely through the vulva at 24 - 30 

hours post-injection and extruded embryos were collected. 

For tissue-specific rescue experiments, worms were selected for application to either empty vector 

(L4440) or tmd-1 feeding RNAi plates based on the dsRed signal. Lethality was counted after 48 hours 

of feeding. Chi-square analysis was performed using the online contingency table form available at 

http://www.physics.csbsju.edu/stats/contingency.html. 

 

Morphological Analysis and Embryo Staining 

4D Nomarski microscopy was performed as described previously [10].  Phalloidin staining was 

performed using a modification of a previously described protocol [11].  Briefly, embryos were 

placed on poly-L-lysine coated slides, aged, treated with 1 mg/ml chitinase in egg salts for 20 min., 

and fixed with a solution of 4% paraformaldehyde, 0.1 mg/mL lysolecithin, 10 mM EGTA, 48 mM 

PIPES (pH 6.8), 25 mM HEPES (pH 6.8) and 2 mM MgCl2.  Embryos were stained with 1:20 

Alexa555-phalloidin (Invitrogen Corp., Carlsbad, CA) overnight at 4oC.  For immunostaining, 

embryos were freeze cracked and stained as described [12] . 

For immunocytochemistry experiments and live imaging of JAC-1::GFP and VAB-

10(ABD)::GFP, embryos were observed using a Perkin Elmer Ultraview spinning disk confocal 

microscope and processed as described [9]. For videos of JAC-1::GFP, stacks of images (12-16 

sections/stack) were taken at 10 sec intervals for 5 min; for VAB-10(ABD)::GFP, 10-30 focal planes 

were captured at 30-120 sec intervals. Some images shown are projections of multiple focal planes. 

Cells in elongating vab-10(ABD)::gfp embryos at the comma stage were scored as having 

discontinuous actin bands if no discernible accumulation of actin could be identified over > 50% of 

their ventral perimeter.  

Actin defects in phalloidin stained specimens were scored as follows. Stained ~1.5-fold embryos 

were categorized into three classes. In class I embryos a clear, thin band of actin at the junction and 

evenly spaced circumferential filaments bundles (CFBs) were apparent, along with a dense meshwork 
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of actin in seam cells. In class II embryos, clumps of CFBs were visible, but the overall amount of 

actin in the embryo was not decreased. In class III embryos, clumping of junctional actin occurred, 

and there was a substantial decrease in the amount of actin present in seam cells. Embryos were 

categorized by three independent assessors and the results compiled. Chi-square analysis was 

performed as above (see Procedures for tissue-specific rescue).  

For measuring continuity of junctional proximal actin networks, a 5 pixel-wide freehand selection 

was hand-traced along individual cell-cell junctions from maximum-intensity Z stack projections of 

phalloidin stained specimens. The selection was then straightened using the “Edit->Selection-

>Straighten…” command in ImageJ. The signal was manually thresholded for each selection using 

the “Image->Adjust->Threshold…” command to include all visible fluorescence along the 

straightened cell-cell boundary. The number, size and total area of thresholded particles was then 

calculated using the “Analyze->Analyze Particles…” command in ImageJ. Since the variances of the 

wild-type and experimental groups failed the F test, pairwise heteroscedastic T-tests were performed 

using Excel and StatPlus:mac (AnalystSoft). To construct box plots, standard box plot conventions 

were used. The first (Q1) and third (Q3) quartiles, interquartile range (IQR = Q3 - Q1) and mean were 

calculated. Extreme outliers were defined as lying beyond the outer fences OF1 = Q1 - 3 * IQR and 

OF2 = Q3 + 3 * IQR. Mild outliers were defined as lying between OF1 and Q1- 1.5 * IQR or OF2 

and Q3 + 1.5 * IQR. Box plots were constructed using StatPlus:mac. 

For analysis of let-502(ts) embryos, worms carrying embryos were shifted to an intermediate, 

restrictive temperature (25.5°C) and grown overnight. Embryos were recovered, stained via freeze-

cracking [10] using MH27 and anti-UNC-94 antibodies and appropriate secondary antibodies (1:50 

α-rabbit-FITC, 1:50 α-mouse-Texas Red), and imaged using spinning disc confocal microscopy. The 

thickness of the junctional proximal actin at dorsal::seam boundaries was measured at several points 

along the perimeter of individual cells using ImageJ (available at http://rsbweb.nih.gov/ij/), and an 

average thickness was calculated for each cell measured. The length/width ratio of each cell was also 

measured in ImageJ using the AJM-1 signal. The resulting actin band thickness vs. length/width data 

were plotted in Excel and a curve fit was obtained using a power law. 

 

Coimmunoprecipitation Assays 

Embryos were collected from 10 large plates grown for 3-4 days at 20°C, homogenized in Lysis 

buffer + 0.25% Triton X-100, subjected to centrifugation to clear the lysates, and precleared by 

incubation on ice with 20µl of a 50% slurry of Protein G-Agarose beads essentially as described [13, 

14]. To perform IPs, 5µl E36 mouse monoclonal anti-GFP (Invitrogen) was added to pre-cleared 

lysate and rotated at 4°C for 1 hour, 40ul of 50% prepared Protein G-Agarose bead slurry (Pierce) 
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was added, and rotated again at 4°C for 1 hour. Beads were sedimented at 3000 rpm for 3 min (4°C), 

washed 3X with Lysis buffer, and 25ul 4x SDS-PAGE sample buffer was then added to preclear, 

prewash, and IP bead fractions on ice.  Collected samples were then subjected to SDS-PAGE on an 

8% gel, along with 10 µl of Precision Plus Kaleidoscope Standard (Bio-Rad), and blotted onto PVDF 

membrane. Blots were blocked using TBST + 5% non-fat dry milk, incubated in 1:2500 primary 

(anti-UNC-94) antibody, washed in TBST, incubated in 1:10,000 anti-Rabbit HRP conjugate, and 

visualized using enhanced chemiluminescence (ECL; Pierce) on X-ray film. 

 

Expression and Purification of Recombinant UNC-94 Protein 

A full-length unc-94b cDNA was cloned into plasmid pKLD37 using a vector provided by I. 

Rayment (Dept. of Biochemistry, Univ. of Wisconsin), which consisted of pET31b with an N-term 

6His-rTEV site. The Escherichia coli strain BL21 (DE3) was transformed with the expression vector 

and cultured in M9ZB medium (Novagen, EMD Biosciences, Inc., San Diego, CA) containing 50 

µg/ml ampicillin at 37 °C until A600 reached 0.6 cm-1.  Protein expression was induced by adding 0.4 

mM IPTG for 3 hours.  The cells were harvested by centrifugation at 5,000 g for 10 minutes and 

disrupted by a French Pressure cell at 360-580 kg/cm2 in a buffer containing 0.3 M NaCl, 50 mM 

NaPO4, 10 mM imidazole, 1 mM phenylmethanesulfonyl fluoride, pH 7.4.  The homogenates were 

centrifuged at 20,000 g and the supernatants applied to a TALON cobalt affinity column (Clontech, 

Mountain View, CA).  Bound proteins were eluted with 0.3 M NaCl, 50 mM NaPO4, 100 mM 

imidazole, pH 7.4.  The fractions containing UNC-94 were dialyzed against 10 mM PIPES, 0.2 mM 

dithiothreitol, pH 7.0 and purified further with a Mono-Q column (Amersham Biosciences, GE 

Healthcare Bio-sciences, Corp., Piscataway, NJ) by elution with a linear NaCl gradient (0.1-0.5 M).  

Fractions containing purified UNC-94 were dialyzed against F-buffer (0.1 M KCl, 2 mM MgCl2, 1 

mM dithiothreitol, 20 mM Hepes-NaOH, pH 7.5).  Concentrations of UNC-94 were determined by 

densitometry of Coomassie blue-stained protein bands after SDS-PAGE using actin as a standard. 

 

Actin Bundling Assays 

Recombinant UNC-94 was expressed and purified as described above.  GST-tagged HMP-1 was 

produced using constructs previously described [4], purified on glutathione beads, eluted with 10 mM 

glutathione, and cleaved with TEV protease in 50 mM Tris, pH 8 in solution. The digest was purified 

using a Sephacryl S-300 column. Rabbit muscle G-actin (20% labeled with DyLight549) [15] was 

polymerized in the presence of chicken CapZ [16] at a 100:1 molar ratio. Filaments were diluted to 5 

µM actin with or without 5 µM HMP-1 and 2.5 µM UNC-94 and incubated for 15 min, mounted on 

nitrocellulose-coated coverslips, and observed by epifluorescence using a Nikon TE2000 inverted 
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microscope.  The curvilinear lengths of resulting bundles were measured using the NeuronJ plugin for 

ImageJ, available at http://rsbweb.nih.gov/ij/. Statistics were performed using Excel and 

StatPlus:Mac. 
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